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1. Introduction

1.1. Congratulations on your new product

You are now ready to work more efficiently and keep the precision at an optimum level. Besides that,

you will be more eco-friendly by doing the same amount of work in less time.

The system is designed to show you the information you need on the screen with the greatest

accuracy.
At the construction site, you are the expert - Makin’ 3D is the best work companion you can get.

We at Team Makin wish you all the best with the use of your new system.

1.2. Maintenance

It is recommended to check the system's accuracy regularly. We recommend that the operator of
the machine frequently checks the positioning against a known point on every job site. See Chapter

12.3: Check the calibration of your wheel loader.

1.3. Storage

Keep the equipment safe when it's not installed in the machine. The use of a protective case is
recommended if the tablet and antennas are removed from the machine to secure the devices from

external stresses such as knocks and bumps.

1.4. Cleaning

The equipment must be cleaned regularly to ensure full functionality over time.

Cleaning is done by blowing to remove dust, you can also choose to use a damp cloth to wipe the

tablet.

Under no circumstances should the equipment be high-pressure washed - neither inside nor outside

the engine compartment.



2. Responsibility

2.1. Installation

All installation and main calibration of the system must be carried out by Makin approved technical

personnel. Failure caused by unauthorized installation or repair could cause a void of warranty.

It is important to follow the machine manufacturer's instructions for installing the Makin machine

control system to avoid violating any machine supplier's warranty regulations.

The user is responsible for using the product in accordance with the given instructions. The user is
also responsible for ensuring that the reference models used are correct and that the bucket is

properly calibrated and controlled.

Broken cables on the system may cause short circuits, system errors, and defective components.
Ensure that no cables have external damage; damage must be repaired immediately before further

use.

Errors in measurement results may occur if the equipment has been subjected to impact, abuse,
modification, or transport damage. Control of the system after such events is important to ensure

an optimum result.

Warranty: For further details, visit www.Makin3D.com for more information.

2.2. Limitations
The product is intended as a control tool, and any use beyond this is not permitted. The supplier or

manufacturer cannot be held responsible for any use that goes beyond the given limits.


http://www.makin3d.com/

2.3. End-user license agreement

License: The system is preloaded with software, which can also be downloaded with permission
from Makin. The software is protected by copyright and other laws. The use of the software is
governed by the license agreement entered into with the Makin’ 3D system when purchasing the

product.

For further legal terms and conditions, including but not limited to the applicable End User License

Agreement between you and Makin, we refer you to visit Makin’s website, www.Makin3D.com.

2.4. Warranty disclaimer

Makin provides this documentation without warranty, term, or condition of any kind, either implied
or expressed, including, but not limited to, the implied warranties, terms, or conditions of
merchantability, satisfactory quality, and fitness for a particular purpose.

Makin, its employees, and agents will not be responsible for any loss, however arising, from the use

of, or reliance on this information.

For further legal terms and conditions, including but not limited to the applicable End User License

Agreement between you and Makin, we refer you to visit Makin's website, www.Makin3D.com.

2.5. Software update

Software will be automatically and frequently updated, and users will get a notification on the screen.
Software updates require a valid maintenance license. To start downloading an updated software

version, users will be asked to agree before the download starts.


http://www.makin3d.com/
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3. Product overview
3.1. Hardware Wheel Loader

Hardware overview

1. Bucket sensor

2. Tilt sensor (Optional)
3. Boom sensor

4. Body sensor

5. GNSS antenna

6. Tablet w. machine control software
7. Docking station for the tablet
8. GNSS receiver

9. Interface Box for system power and
data communication



3.2. Tablet buttons and light indicators (Panasonic FZ-A3)
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1. On/Off button 4. Quick access to tablet's menu

2. Volume up 5. Not in use. The button can be
programmed (more info below).

3. Volume down 6. Not in use. The button can be
programmed (more info below).

Additionally, screenshots can be taken by pressing the ‘On/Off button’ and ‘Volume down’
(simultaneously holding down buttons 1 and 3 for about two seconds). This can be useful in the

unfortunate case where assistance is required. Find the screenshots via the ‘Photos’ app.



3.3. Software

3.3.1. How to turn the system on

1) Turn on your Makin’ 3D system by pressing the on/off button on the tablet. Android will start
up and present the ‘Lock screen’.

2) Swipe upwards with one finger on the touchscreen to access Makin’ 3D.

3) If no project has been previously loaded, you will be prompted to do so. See Chapter 4.7:
Open or create a project.

3.3.2. Elements of the work screen

Makin’ 3D offers a variety of screens to choose from. Below is a description of one that includes

most of the available visual features.

mMAIcrT S0




Top bar with status indicators for
connectivity. It also contains features for
resetting the pan and zoom level as well
as changing between screens.

Indication of the slope in the main
direction of the tool point. The arrow
indicates the vertical distance to the
selected height reference. The arrow will
change color depending on the distance
to the target. Tap the indicator to change
the height tolerances.

Indication of the slope in the cross
direction of the tool point. The arrow
indicates the horizontal distance to the
selected side reference. The arrow will
change color depending on the distance
to the target. Tap the indicator to change
the side distance tolerances.

Info bar for Easting, Northing and Height
coordinates.

Tap any element in the loaded 3D model
to bring up the References dialog.

6.

9.

Tap the bucket (also in the static views)
to change or calibrate the machine’s
bucket.

Station: Indicate where on the centerline
you are located. To the right of the
Station, you can see the slope along the
road

CL: Distance to centerline. To the right of
the CL, you can see the slope across the
road.

Height: Name of current Height Reference

Side: Name of the current Side Reference.

Change the height offset according to the
current reference - e.g. the specified plane
or the loaded model file.

Quick keys are shortcuts to features
found in the menu.



3.3.3. Touch gestures

Gesture Action

Use one finger to rotate a 3D View.

Use two fingers to pan a Top View or 3D View.

Spread or pinch two fingers to respectively zoom in or out of a Top View or 3D
View.

Tap to select.

Sometimes it is possible to long-press for further options.

T | T LA | A




3.3.4. Symbols in the top bar

Symbol

Function

()

Indicating a connection to the internet. The symbol appears white when a
connection is established and gray if there is no connection.

Indicates the number of visible satellites. hRMS (Horizontal Root Mean Square)
and vVRMS (Vertical Root Mean Square) indicate the current GNSS accuracy.
Tapping the icon will bring you to the GNSS status menu.

Indication of synchronization of data between server and machine.

An indication that you have remote support from Makin.

This will usually be in connection with a remote support case where you will be
notified.

Bring your machine back to the center of your screen after zooming and
panning.

Placed in the upper right corner. Tap for a change of screen, depending on the
work you are doing and what you want to have in focus.

Toggles between 2D (top view) and 3D view. This button is always placed on
the work screen that it toggles.

o= e

Indicating project offset. The symbol appears when a project offset is applied
to the active project.

The tablet is connected to the cloud.

Synchronize to the cloud.

The tablet is not connected to the cloud.

The tablet is disconnected from the cloud because of a secret project.

This symbol is a sensor status indicator. See the pop-up notification for more
information.




3.3.5. Quick keys on work screen

lllustration Menu ID Function
References Tap to access the References menu. Another way to access
4 this menu is to select an element in the 3D model.

NB!
Long hold to access the Project menu.

Log point Tap to quickly log a point, which will be stored alongside
general as-built data.
NB!
The name of the current object is shown on the icon’s label.
NB!
Long hold to access Objects. You need to select an object
before logging a point.

Log line Start logging a line by adding line log points.

NB!

You can select aline and edit it. Select it as a Point of Interest,
name it, and add a comment to it. You can also edit the line
point’s offset. You need to select an object before logging a
line.

Disable log line

Stops the line logging.

e 9

Bucket menu

Tap to access the Bucket menu.

Main menu

Menu from where you can access all features of the system.




Main menu

( Main menu

“ @ it 9O

Project Display Settings Logging

o B A

Bucket Chat Status Manual




4. Project

Working according to any kind of design is considered a project, whether it is a simple relative plane

or referencing lines and surfaces in more complex 3D models.

<Mainmenu Ex
“w @ it 9 ¥

Project Display Settings Logging GNSS

Bucket Chat NES W ELIE]

4.1. Open or create a project
To open an existing project:

1) In ‘Project’ tap ‘Open project’ to see all the projects stored. This dialog is automatically

opened if no project is loaded.

< Project

ﬁ Open project
Y Project filter

ah References

v Plane




2) Tap on the project you want to open, and the download starts.

< Open project + ‘__’ E X

aA Construction project

aa New hospital

aA Project E12 west
4aA Project E12 east
a4A Railway project

AA Test project

3) If you want to create your own local project, tap the ‘+ icon.

< Open project + .__’ E X
aA Construction project
aa New hospital
aA Project E12 west
4aA Project E12 east

A Railway project

AA Test project

4) Tap on the local project icon.




4.1.1. Create a secret project

You can create a secret project that will only be available on your tablet and will not synchronize to
the Makin’ Cloud. Secret projects are useful for construction projects needing confidentiality due to

security, critical infrastructure, or competitive advantages.

1) Go to project > Open project
2) Tap on the ‘+-symbol

3) Tap on the ‘secret project’ icon

4) Name the secret project

The icon in front of the project name indicates that it is a secret project:

< Open project + ‘__' m X

4aA Construction project
a4 New hospital
&% Project A6 north

4aA Project E12 west

A Railway project

4A Test project




4.1.1.1. Remote control for secret projects

If you need support while working on a secret project, you must grant support access to your tablet
during remote control. The secret project will be disconnected and will not synchronize to the Makin'

Cloud, as indicated by this icon:

o\

The support staff can see that your system is online on the Makin' Cloud, but they will not have
access to any details about the secret project. To get support while working on a secret project, you
need to give access to the support staff. When the support staff initiates remote control, a

notification will pop up on your tablet:

Remote Control Request

Do you want to allow remote control access to your
system?

X 4

To allow remote control access, tap on the check mark.



4.2. Transfer files

You can transfer files via USB flash drive to secret projects, local projects and cloud projects. You
can import files to the project and export as-built data from the project. Please note: If you import
files to a local project or a cloud project, those files will be available on Makin’ Cloud. For more

details, see section 4.2.1.7., Imported files on Makin’ Cloud.

1) Tap on the ‘transfer files’ icon.
< Open project + ‘__’ E X
4aA Construction project

a4 New hospital

4% Project A6 north

4aA Project E12 west
aA Railway project

a4 Test project

2) Choose between import to project or export as-built data from the project. Learn more about

importing and exporting in the sections below.

( Transfer files

B Import to project

B> Export as-built




4.2.1. Import to project
You can import files to the project via a USB flash drive. You cannot import single files but only
folders from the USB flash drive. Please note: If you import a file with the exact same name as an

existing file in the project, the new file will overwrite the existing one.

How to import files to the project:

1) Important: Insert the USB flash drive into the tablet first.

2) Tap on ‘Import to project'’.

< Transfer files

B Import to project
B> Export as-built

3) You will now be directed to Android's dialog.

4) The first time you insert the USB flash drive you need to make sure that the USB flash drive

is selected. Tap on the ‘three stripes’ icon in the top left corner.



0841 ) t ™M 8}

FZ-A3
K Name A
B Alarms @8 Android @8 bluetooth 8 com.panasonic...
@8 com.panasonic... @8 com.panasonic.... i ociv @8 DiagnosticResu...
@8 Download B8 Makin B8 Movies B Music
B8 Notifications B8 Pictures B8 Podcasts B8 Ringtones

SELECT

5) Tap on the name of the USB flash drive to open it.



0843 ) t M} -

Open from
©  Recent
3 Downloads
FZ-A3

29,43 GB free

B Pretec USB drive
337 GB free

6) Tap on the folder you want to import files from.



7) Tap on ‘select’. Please note: All the files in the folder will be imported

single files.

0844 ) T ™M R -

Pretec USB drive

@8 Trash-1000

@8 Construction

| html

B8 Models roads

B8 Pictures

B8 secretfiles

Alarms

DCIM

LOSTDIR

Movies

Podcasts

System Volume...

@8 Android
B8 Documents
B Music
B8 Recordings

BB Test

Name A

Audiobooks
Download
makin3d_sysro...
Notifications

Ringtones

SELECT

. You cannot import



0844 ) Tt ™M} -

= Makin v
Name A
B8 Projects
¢y 60100_1.xml ¢y Clroad.xml ¢ Ditchxml ¢ Linejunction, xml
0B 6Jun 2,13kB 08.31 1,78 kB 17 May 1,78 kB 17 May
¢y Lines-Driveway <> New yard-ver2. ¢y Pipe lines.xml ¢y Water. xml
78 kB Jun 2,13kB 08.31 1,78kB 17 May 2,13kB 08.31
—>

8) Import of files is completed. You can view the files under Project > References. The

imported files will be marked with a *.

< + 1297 X
mm Project A6 north @e t
> 60100_1.xml *
>
> contour lines_15263.dxf *
> contour lines_15264.dxf *
> contour lines_15262.dxf *
v
v

o P4 (0)
o P3(0)




4.2.1.1. Imported files on Makin’ Cloud
When you import files to a local or cloud project, they will be available on Makin' Cloud. However,

these files will be stored in your system’s project folder, and not as part of a global project within

your organization.

How to find imported files on Makin’ Cloud:

1) Go to Makin’ Cloud > Choose organization > Systems

IMAICHTT Organizations

Dashboard Projects

Makin

Users

Licenses

Transfer

Suborganizations

Settings

Q Search | | All systems &} G

Systems 7onine /38

Overview of all systems

Search systems.

System

i Andi-pc

i Daniel FZ-A3

i HJ Entrepreneur
i Morgan Tablet

i Andreas MakinWin
i Andreas telefon

i Ash-A3

i Ash-PC

iaw2

i Brian_pc

i Daniel PC

X

Filter ¥

No.

000-399

000-021

201-002

000-000

100-8000

000-1234

000-4321

000-093

000-0000

000-022

Owner Renter

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Makin

Project

Makin Road

vandvaerk, indmalinger
ENG - road project demo
Morgan Home

SK Hjem

!HJ Demo

0_SL_test_daniel

2) Select the system that imported the files.

3) Open the project folder under that system.

ITIAICIIT Organizations

Dashboard  Projects

Makin

Suborganizations

Version

VTI-25

v2.26.x-b81

v2.26.x-b97

v2.26.x-b97

2.16.0°

v2.24.10

v2.25.3

v2.24.12"
veloud_v24.1.1-112-gc3efd6
v2.22.3

v2.23.14

L]

Release group
v dev2.26.x
v dev2.26.x
v dev2.26.x
v testing

Systems

. View on map I

os

{ x86_64
& ARMB4
& ARMB4
& ARMB4
= x86_64
& xe5 64
& ARMB4
SEx86_64
{ x86_64
=2x86_64

=85 64

Ordered systems (0)

Add system +

GNSS

11(0.0)
11(0.0)
11(0.0)

33(0.9)

HJ Entrepreneur online

Download folder
files
Name

Config

correction_profiles.json

global.mdb
global.mdb-lock
makin.log
makin.log.1
makin.log.2

pointcodes. txt

Size

1.6 KiB

260.0 KiB

8.0 KB

588.1 KiB

1.0 MiB

1.0 MiB

278B

Last modified
2 hours

3 hours

24 days

2 hours

2 hours

2 hours

aday

aday

3 hours

Files H

Actions



4) Select the project where the files were imported.

IMAICIIT O

Files  Hardwa Fix points zal project

Dow fol
files / Projects

Name Size Last modified Actions
2780 6 months Y
60100 ayear
60400 7 months &
63000 7 months &
63100 7 months &
63600 4 hours &
IST-773 8 months &
EH2021-1 8 months &
2.20 test 10 months &
22000 7 months &

37536 7 months &

5) The imported files will be available in this folder.

4.2.2. Export as-built
The USB export function allows you to export locally logged as-built data directly to a USB stick.

This makes it possible to transfer project data without requiring access to the cloud.
Note: Only the as-built data logged by the current user can be exported.
When performing a USB export, the following files are generated:

e LandXML file: Contains points and lines from the as-built logging.

e ZIP file (attachments): Photo documentation for all images linked to the logged points.



Steps to Export As-Built Data via USB:
1. Insert the USB flash drive into the tablet. Please note that it is very important that this is done
as the first step.
2. Open the menu Open project.
Tab the icon displaying the two arrows (Transfer symbol)

4. Tap on ‘Export as-built'.

( Transfer files

&5 Import to project
B> Export as-built

5. You will now be directed to Android's dialog.
6. Make sure that the USB flash drive is selected. If not, tap on the ‘three stripes’ icon in the

top left corner and select the USB flash drive.

0844 ) T M R -

=  Pretec USBdrive

Name A
B8 Trash-1000 8 Alarms B8 Android B8 Audiobooks
B Construction i ocim B Documents B Download
B htm! B8 LOSTDIR B Makin B8 makin3d_sysro
B Models roads B8 Movies B Music B8 Notifications
B8 Pictures B8 Podcasts B8 Recordings BB Ringtones
BB secret files @8 System Volume BB Test



7. Tap on the folder where you want to save the as-built data.
Tap on ‘Select’. This will export the project’s as-built data to the chosen folder. A pop-up

notification will indicate that the export is in progress.

e Please note that in most cases, the process is completed so quickly that this notification

may not appear.

0853 B) *t ™M § -

= Makin v

Name A

B Projects

<> <>

¢y asbuiltlens_t.. ¢ asbuiltHjtest-
1,78 kB 17 May 2,13 kB 08.53

—’ SELECT

9. The project’s as-built data is now saved in the selected folder on the USB flash drive. When

the export is complete, a confirmation pop-up will be displayed on the screen.



4.3. Supported file types
When creating a project, the following file types are supported:
e LandXML Roadrunner format (XML)

e Drawing eXchange Format (DXF)

¢ Norwegian coordinate and observation format (KOF)

New projects are stored in LandXML format.

4.3.1. Project filter

Note: When Makin’ 3D reaches 170 MB data in size, a warning will pop up, informing you that the project
is large. This can reduce performance. The file size depends on the complexity and the details in the
model.

() = X % ﬂ

Simulator

N eres’  Projectsizeistoobig ¢

Ej6410828'93 Failed to load the following files:
: : Big file/Sewage project/

E18/13700-1_Surface.xml

Filter

If the project reaches 170 MB data in size, part of the model will be shown on your tablet screen near
the application, while the rest remains hidden. As you move the application around, the visible part

of the model will adjust to stay aligned with where your application is.

You can choose to load a part of the project file under Project > Project filter or click ‘Filter’ in the

notification (see picture above).



() ==

| —
N: 1124108.42
E: 611027.96
H:99.86

Project
Open project
Project filter
References
Geodetic systems

DKTM3, DVR90

Extend surface

Plane

1) Select the folder you want to activate and load by clicking on the button. When the folder is

activated, the button will turn blue.

N: 1124108.42
E: 611027.96
H:99.86 ___

< Project filter
o Driveway

Surfaces

o
® Vegetation
(]

Yard




2) Deselect the folders you do not want to load by clicking on the button in front of the folder’s

name. When deselecting the folder, the button will turn off.

() = X

Simulator

N: 1124108.42
E: 611027.96
H:99.86 _

< Project filter
Driveway
Surfaces
Vegetation

Yard

The activated folders will be loaded and displayed under ‘References' in a petrol blue color, along

with the files from the folders.

N:1 109.89
E:611026.12
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You can create folders on Makin’ Cloud and then drag your project files into these folders: Makin

Cloud > Project > Choose your project > New folder.

4.4. References

In the ‘References’ dialog, you can choose which part of the 3D model should be active/inactive and

what should be selected as height references, side references, and alert references.
Height references can be points, lines, and surfaces.

Side- and alert references can be points and lines.

< B+lA°7'AE

mm Road Project
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v Road model
Vv Surface
> Surfaces
vV Lines
’ -1.01_0_Asphalt

centre_road
_/ 1.01_0_Asphalt

> X 00S B 200 20 001 Foundatl e

1. Tap one of the symbols to select all 4. Green is used for elements that may
elements in the project reference the height. Press to select as
reference. Long press will deselect all



2. White means an element is visible and
activated

3. Blue indicates an element used as a
side reference. Press to select as
reference. Long press will deselect all
other side references selected

selecting any element in the 3D model.

8.20 m

W Clvej(51.67m) @

Centerline-road

other height references selected

5. Red is an alert reference, which gives a
warning when the tool is too close to the
element. Not applicable for surfaces.

6. Highlight elements with yellow color in
the 3D model

As an alternative to going via the menu, you can also find this feature in the Quick Keys menu or by



4.4.1. Folders

In the reference examples below, we see all the data that has been entered on a road parcel.
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N: 1124109.43
E 61101725
H: 97.61
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EEEEEERO
L

New yard-ver2.xml
New-lines-yard1-2d.dxf »
Lines-yard-north.dxf

In this example, we have six folders:

e Road Models
e Water & drain
e Electricity

e Construction
e Landscaping

e Sewage

If you enable options (i.e., set visible, side reference, height reference, alert reference) for a folder,
you enable the option for all models in the entire folder. For example, if you have many road models,
you may want to open the folder with the small gray arrow to the left of the folder and only activate

the road models that you need.



(@) X

N: 1124109.43
E 61101725
H: 97.61
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Line junction
Drainage
Rainwater

Folders are shown in blue text - model files are white. File and folder names are scrollable, indicated
with a tiny yellow arrow to the right of their names. A star following a project name indicates the

project is local.

In the above example, we have opened the folder for road models, which contains several individual
files. You can turn on all elements of a folder or turn on some details by expanding individual folders.
Within the folders, you can select specific data to make visible and choose what to actively work

against.

To get an indication of the different model files, side and/or height must be activated. As with
viewing, you do this by tapping the respective blue and/or green boxes. By enabling visibility, side,

and height in combinations, you can customize what information you want on the screen.



4.4.2. Visible reference

All geometries are visible by default and can be hidden by deselecting the white square next to them,

beneath the eye symbol. Calculations are only performed according to visible layers.
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N: 1124109.43
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H: 97.61
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Line junction
Drainage
Rainwater

For example, if we want to make all roads visible in a group of models, simply check the white box
to the right of its folder. It will make all roads visible on the screen. If we only want to see one road,

just activate the white box to the right of the particular road file.



4.4.3. Side reference

Side references are geometries used for side calculations. When models are activated, they have a
blue color next to them, beneath the symbol with the horizontal arrow in the ‘Reference’ dialog. The
closest geometry, activated for side reference, will automatically be used. Lines and points can be
selected as side references - not surfaces. The calculated side distance is the horizontal distance

to the geometry.

4.4.4. Height reference

Height references are geometries used for height calculations. They are indicated with a light green
color when activated in the ‘References’ dialog, beneath the vertical arrow symbol. The lowest
geometry, with height reference enabled, will automatically be used. Height references are typically

surfaces, but lines and points can also be selected for height calculations.

4.4.5. Alert reference

Alert references are geometries used for alert calculation. The closest geometry activated as an
alert reference with a red square beneath the warning symbol will automatically be used. Lines and
points can be selected as alert references - not surfaces. Unlike the calculation of side reference,

the calculated alert distance is the closest Euclidean distance (shortest path) to the geometry.



4.4.6. As-built data

As-built data is data used for documentation of the performed task. As-built data can be used in
different ways: to document that the project is built the same way as it was originally designed or to

document if extra work has been performed, e.g., how much soil is being removed from an area.

The as-built data is collected when the machine works, and the data is logged by the operator. This
data can be used later in the process to assure the quality of the project and/or to calculate the
volume of material that is added or removed from an area. As-built points will be saved in the

overview if it is necessary to navigate to the points at a later stage of the project.

As-built data can be used as references in a similar way as other references. The green points are
your own points, and the purple points are points from other applications. The lines and points are
continuously saved and synchronized to the Makin’ Cloud, where they can be downloaded as .CSV,
.KOF or XML formats.
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4.4.7. Lock Reference (line, point, or surface)

Makin can work with multiple active references at the same time. This allows the user to activate
and work with the references when moving the tool point over them. The active reference will
automatically switch to the one closest to the tool point. While doing this, and with a lot of references
often close together, it can be difficult to avoid the references from switching if you want to navigate
to a specific height or side reference or to a reference further away than other selected references.
In this case, the user can lock a reference, isolating the navigation to this specific reference without

deactivating all other active references.
You can select and lock a line, point, or surface that will be used as a reference.

If you are moving the tool point around on the project, the height and side reference will keep being

locked to the selected reference, thus keeping this as the reference.

Locking a reference can be done in the reference menu or directly on the work screen:

1) Select an object by pressing the object name or directly on the visualized object on the run
screen.

2) Press the lock icon to lock the selected reference.

0.0%

B leftside

3) Select ‘Side’, ‘Height’ or both:

0.0%

Bl leftside

You can see that both ‘Side’ and ‘Height’ have a lock on them.



Bl leftside

4) If you want to unlock it again, just tap once on the lock, and it will disappear.

5) If you want to lock the reference directly under your tool point, this can be done by pressing
the lock icon next to the reference name in the work screen. This will toggle the lock icon

between open and closed for either height or side reference.

N: 6751686.94
E..604289.08,
H:143.61

Station: 380.33m -30
1.38m 2%
: 1.1_Trau_60100 &
1.1_Trau_60100 (389.
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4.4.8. Dynamic 2D files

2D files, also known as background files or display models, are defined as files with no height
information available. The height of all points in the file is set to 0.00 meters. These files are often
used as background to visualize existing infrastructure or drain pipes where height was not logged
originally. When working on projects with the 2D files, they are not placed at a height of 0.00 meters.
They are moved closer to the project, right below the active 3D references' lowest point. These files
are handled dynamically, so whenever a 3D reference is activated or deactivated, the 2D files adjust

accordingly.

SIS




4.4.9. Copy Point

You can now copy and edit a point by selecting one from the design model. However, it should be

noted that you are not able to modify the points in the design model itself.

By using the edit feature, you can change the point's properties, such as its height. The edited point

will be saved under your own points list (user model).

Additionally, you can utilize the Copy Point feature to duplicate any points from your personal point

list.
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4.4.10. Stakeout

Stakeout shows the information for the selected line, point, or point on a line. To stake out an
element, press the element in the graphics or press the element name in the reference dialog, and
press the stakeout icon at the top of the reference dialog. A popup will appear with all the stakeout

information for the selected element. The stakeout menu can be freely moved around on the tablet.
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Measurement
— Horz Dist 1.38 m
Vert Dist 1.19 m
Incline 861%
# Station 380.33 m
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Stakeout

Measurement

Measurement: Shows measurements between the tool point and the selected reference for the

stakeout.
Reference: Shows information about the entire selected reference for stakeout.

Segment: Shows information about the active line segment (gray line). Only shown for lines that

contain segments.

1. Horizontal distance between tool 8. Horizontal length of stakeout line.
point and selected reference.
Measured perpendicular to the line.

2. Vertical distance between tool 9. Length of stakeout line.
point and selected reference.



Inclination between selected
reference and tool point.

Stationing of the selected line.

Horizontal distances from present
stationing to the end points of the
active line segment (colored gray).
The line will be extrapolated, if the
tool point is in front or behind end
points. In this case, the value will be
negative to the closest end point.

Name of selected stakeout line.

Type of selected reference (arc,
circle, line, polyline, road line)

10. Segment type can be line, arc, or clothoid (spiral,
transition curve).

11. Horizontal length of line segment.

12. Length of line segment.

13. Height difference of the line segment.

14. Slope of the line segment.



4.4.10.1. Stakeout to a point

When you want to stake out to a point, you can press the point or click on the name of the point in
the reference dialog, and then press the stakeout icon AE

A bullseye and a popup with the stakeout information will appear on the screen. The blue line in the

bullseye indicates the long slope direction, and the red line indicates the cross slope direction.

The popup with the stakeout information will show information about measurement and reference.

/ Measurement
Horz Dist 5.97 m
Vert Dist 1.00 m
Incline 9.5°
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Reference

Name: P56

Type: Point
Category: Logpoint
N: 1124343.34

E: 610971.24
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4.4.10.2. Stakeout to a line

When you want to stake out to a line, you can press the line on the screen or click on the name of
the line in the reference dialog, and then press the stakeout icon AE

A dotted line from the application to the selected line will show on the screen, along with a popup
with stakeout information. The stakeout information will show information about measurement,

reference, and segment.

If you move beyond the ling, the dotted line will show the extrapolation of the selected line. Please

note that if you stake out to a side reference, the line does not extrapolate.

Stakeout »

FIXED
Name: PolyLine1
Measurement
Horz Dist 3.71 m
Vert Dist 0.84 m
Incline 12.8°
Station 322.28 m
Delta station
9.61/0.47

o
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> Points .
> Vej.xml [ |
> Vej2.xml
> Vej2A.xml




4.4.10.3. Stakeout to a line point

If you want to stake out to a point on a line, you must press the arrow between the line symbol A

and the name of the line in the reference dialog. Then the name of the line point will appear

underneath the arrow. Select the line point you want to stakeout to, and then press the stakeout icon

Al

H: 99.76

< + LU XL + 2 4@ v[1 X
mm Road projectDemo A @ < § mm Road projectDemo A @ < §
Vv Lines Vv Lines B
PolyLine1 [ ] / v PolyLinel [ ]
PolyLine2 [ | P1 (PolyLine1

)
PolyLine3 P2 (PolyLine1)
PolyLine4 [ ] o P3 (PolyLine1)

Points o P4 (PolyLine1)
Vej.xml o P5 (PolyLine1)
Vej2.xml o P6 (PolyLine1)
Vej2A.xml P7 (PolyLine1)

A bullseye and a popup with stakeout information will appear on the screen. Like stakeout to a point,
the blue line in the bullseye indicates the long slope direction, and the red line indicates the cross

slope direction.

The popup with stakeout information contains information about measurements and references.



4.4.10.4. Stakeout to side reference

You can stake out to side references, which allows you to see multiple elements’ information by

jumping between them when you use the stakeout feature.

How to use:

1) Activate the elements you want to use as a side reference by pressing the boxes underneath
the blue horizontal arrow in the reference dialog. When you activate a box with a blue edge it

will change to a fully blue box.

2) Press the stakeout icon A E

3) The application will now stake out to the nearest element, and when you move around, the
application will switch to stake out to a new nearest element. A popup with stakeout

information will also appear on the screen.

The popup with stakeout information will show information about the name of the element,
so you know which element the application stakes out to. The popup also contains

information about measurements and references.
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4.4.11. Create point from coordinate

1) Press on References:

6 Main menu | Project

44 Open project
Al References

2) Pressthe '+

3) Press the pointicon:

< + 12 2[4 X
mm ENG -road projectder @ « §
>

>

> CL-road.xml

> Ditch.xml

>

> Lines-Driveway4.xml

> Lines-driveway-2D.dxf

> Lines-driveway.dxf

vV Lines-driveway4.dxf

< o Iz
B ENG - road proj jle

p—

@

CL-road.xml
Ditch.xml V

Lines-Driveway4.xml
Lines-driveway-2D.dxf
Lines-driveway.dxf

Vv Lines-driveway4.dxf

The point will have the coordinates of the tool’s selected measurement point.



Create point f) E

Name P4
Northing 1124161.24 m
Easting 610952.79 m
Height 101.39 m

v

4) Set a name for the point.

5) The point’s coordinates can be adjusted manually.

6) Itis also possible to adjust the tool’s position and fetch the new position of the tool (see the

tool icon in the picture above).

7) Tap the check mark to confirm the new point.

Points you have created yourself can be found at the bottom of the References under User model >

Points.



4.4.12. Create line from points
1) From ‘References’ tap ‘+' and then ‘Line’.

You can create lines between existing points - either from a design model or from points you have

created yourself.

The line will be created in the order in which points are selected, and you will see how the line appears

in the on-screen overview.
2) You will be prompted to ‘Select the points for the line’.

3) Select the points individually by either picking points in the 3D visualization or highlighting

the yellow icon next to them in the list.

4) Finish by pressing ‘OK'.
5) Give the new line a name.

6) If you have selected three points or more, you can select the ‘Close line segment’ option to

connect a line between the first and last points.

7) Finish the line by pressing ‘OK'.

8) Finish the line by pressing ‘OK'.



4.4.13. Create profile along lines

1)

From ‘References’ tap ‘+' and then ‘Profile’ . )

The line will function as the centerline for the profile, where you can add any number of surfaces on

either side of the line.

2)
3)
4)

5)

6)

7)

You will be prompted to “Select the lines for the profile”.

Select the lines for the profile in the 3D visualization or in the list. When done, tap ‘OK'.

Give the profile a name.

Press the ‘+' button on the left and right side of the screen to respectively add new surfaces

on the left or right side of the line.

Adjust each of the surfaces’ width, Deltaheight dH, and angle according to the design that

you want.

You can also adjust the height offset of the entire profile.



4.4.13.1. Edit profile

You have the possibility of editing an existing profile. In this way, you can edit the profile’s width and

slope of the surfaces, as well as add or remove surfaces.

1) Under User model; longhold on the profile surface name, which you want to edit.

2) Click on the pen tool, which will appear.

< + L2075, vDdX
m Road project Demo A « {4
v Surfaces
-3
-2
-1
1
2
3
> Lines
v Road project

3) Adjust the width, the deltaheight dH, and/or the angle of the surfaces by clicking on the

numbers you want to change.
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4) The profile will now change according to the new width and slope of the surfaces.

4.4.14. Edit Line
You can edit line points in the user model if you need to change the coordinates/location of an
existing line. Be aware that you can only edit your own lines located under the user model, meaning

that you cannot edit lines from project- or As-built data.

1) Go to References > User model > Lines.

2) Click on ‘Lines’.

3) Choose the line you want to edit by clicking on the line or the arrow in front of the name of

the line. For example:



¥ v

4) Click on the point of the line you would like to change, for example:

P2 @FL@T?}& edge)

 F4erdVv[TX

mm Road project Demo A
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/ W Left edge
o P1 (Left edge)
P2 (Left edge)
o P3 (Left edge)
o P4 (Left edge)

o P adg

5) Click on the pen tool to edit the line point.

6) Change the desired coordinates of the point’s position. The line will now change in relation

to the point’s new position.
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4.4.14.1. Copy a line from design data in order to edit it

Because you cannot edit lines from design data, you can instead copy a line from the design and
edit the copied line points in the User model. In this way, you can still follow the line and adjust the

line points, e.g., if you want to change the height of a line point.

How to copy a line:

1) Select the line you want to copy from the design.

2) Click on the ‘Copy’ icon:

3) You can rename the copied line. Press ‘Ok’ to copy the line.

4) The copy is now under ‘User model’, where you can edit the line.



4.5. Infield Design

To open the Infield Design function, go to the Reference menu.

1. Click the + icon on the menu bar in top of the Reference menu.

2. This will open a drop-down menu. Select the Infield Design icon.

3. Wait for the Infield Design section to open.

4.5.1. Points and lines in Infield Design
The Infield Design is equipped with an Add point- and an Add line-button.

1

AN

Add suliface

é

Exit Infreld




Use these to add the needed data or work from already logged data. The workflow when logging

points and creating lines in Infield Design is almost the same as when logging regular as-built data.

1. Click the icon for the data you need to log.
2. Place the tool point in the correct position.

3. Click the Add point from TP-button on the screen. This will log a point.

@ff

Simulator

9, Add points X
Add peint from TP Add points from tool by pressing the add poffit

button.

— 0] §

4. Move the tool point to the next position.

5. Repeat until all desired points are placed and click the OK button.

Please note: If you close the pop-up window by pressing the X, all data created before pressing OK

will be deleted, and it is not possible to recover it.



4.5.2. Info box for line

When a line is created, you can access its relevant information. Simply select the line and click the

Info-button on the left-hand side of the screen. This will open a pop-up window.

oy &

Simulator

Info

2D length: 24.35 m
3D length: 24.57 m

4.5.3. Create a boundary

1. When the points are logged, click the Add surface-button.
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Add line
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2. Click the Boundary-button.

e

Simulator

Create surface x
Boundary Select points for the surface, or add points ffom

@ tool by pressing the add point button.

——

Add point from TP O k
—_ —

3. Select the points there are a part of the boundary and click OK.

Simulator

| i
® Create Boundary x
int

Add point from TP Select points for the boundary line, or add p
from tool by pressing the add point button.

® P4(0)

4. Aboundary has been created.



4.5.4. Calculate volume
1. Start by creating a surface based on your boundary.
2. Click the Add surface-button.
3. Click the Boundary-button and select the created boundary. When selected press OK.

& # ®

® Create Boundary x
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Add point from TP Select points for the boundary line, or add p
from tool by pressing the add point button.
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4. Select the top points to create the surface. When the points are selected, click OK to create

the surface.
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5. Select the surface and click the Volume to boundary-button to calculate the volume.
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Simulator

M

Volumefte floor

Volume to boundary

©

6. This will open a pop-up window showing the volume.

o K

Simulator

A Volume x

Volume to floor Volume: 96.69 m?

vt Make Report

Volume to boundary

®

7. If more information is needed, click the Info-button to open the info box.

& % - ©

Info

2D Area: 79.83 m?
3D Area: 106.93 m?
2D Circumference: 37.34

m
3D Circumference: 37.34
m




4.5.5. Infield Design report

It is possible to create an Infield Design report with all the relevant measurements. Create the
report by clicking the Make report-button, this will export the data to Makin’ Cloud. Please note that
the report can only be generated once the volume has been calculated and Infield Design has
collected all the relevant data.

& ¥ ©®

n Volume X

Volume to floor Volume: 96.69 m3

A Make Report

Veolume to boundary

0) N

Go to the cloud and open the PDF. Please note that the image in the report is a screenshot taken at
the moment when ‘Make Report' is clicked. It is therefore important to be aware that the screen
displays the measured area if you want to have the correct area shown in the report.



4.5.6. Exiting Infield Design

To exit the Infield Design click the Exit Infield -button or the Infield Design icon at the bottom of the
screen.
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4.6. Geodetic systems

Only in rare cases should the machine operator be concerned about selecting the correct coordinate
system and geodetic model. With Makin’ 3D these matters are handled in a central place - e.g., the
construction office. When made available, the geodetic system cannot be changed on the excavator.
It is possible though, to handle the geodetic system locally when required by simply not having it

preselected for a particular project.

4.7. Extend surface

Extending the surface allows you to continue your excavation even if you are beyond the design that
is already at hand. By selecting ‘Extend surface’, you extend the road surface you are working on -
even if the actual design has limitations. The same is true for cuts where the cutting surface is too

short for you to find the cutting top.

(@) f’i : = @,rj' Project E x

N: 1124141.79 .
E: 610980.73 Open project

H: 102.29
Project filter
References

Geodetic systems ~ »

DKTM3, DVR90_2013

Extend surface o

Plane >

Temporary profile )

Prniect nffeet N NN m

The way the surface extends depends on the file format you are using:

Road formats: For road formats like road lines and xml. files, the surface will extend perpendicular

to the centerline when you select ‘Extend surface’.



Other formats: For surfaces with other formats like dxf. and landxml. the surfaces will extend with
a heading cut across, when using the feature ‘Extend surface’. It means that the extended line will

move along with the bucket’s cutting edge.

Note that when you extend the surface, only the current tool point’s height will be shown when you are

beyond the design. Only one height will be calculated, which will be the height from the active tool point.

Extend surface using road formats:

© %

N: 1124140.31
E: 610986.17
H: 102.04

Extend surface using other formats:

@) #

N: 6240807.46
E: 461800.22
H:55.50




4.8. Plane

By activating the ‘Plane’ feature, you get a virtual reference plane, which can be either flat or sloping

with a 1-sided or 2-sided fall.

(@) f

N: 6751664.86
E: 604280.17
H: 143.61

Station: -
Gl -
Height: Plane &=

Use ‘Main direction’ and ‘Main slope’ to indicate the plane’s longitudinal direction and angle.

Likewise, set the transverse slope of the plane with ‘Side slope’.

With the ‘Elevation’ option, specify the absolute elevation height or quickly get the current height of
the tool point. Another option, called ‘Set plane here’, also uses the current tool point height, but with

the addition of taking the reference height offset into account.

When the plane is active, you can tap the visual part of the plane to quickly change its values. When
you no longer need this feature, it is important to disable the plane. If you do not do this, the activated

plane will follow the machine wherever it may be located.

Tap to activate and deactivate a virtual plane and change the longitudinal direction, longitudinal

slope, and transverse slope.

If you set the height manually and then enter a longitudinal fall, the point for starting the slope will
still be below the "cross thread", which forms the center of the measuring point on the bucket. Those
are the E and N coordinates that you can see in the upper left corner. It is important to keep in mind

that the measuring point on the bucket is above the desired starting point for length/cross slope.



4.9. Temporary profile

Toggling the ‘Profile’ option turns the temporary profile on or off while its settings are retained.

There are two options for moving the profile, respectively ‘Set profile here’ and ‘Set profile &
direction here’. The first option horizontally displaces the profile and positions the middle of its
centerline at the tool point. In addition, the latter option also rotates the profile according to the

heading of the bucket/attachment.
Adjusting the ‘Slope’ will tilt the profile along its baseline.

Under ‘Edit profile’ you can change the profile’s contours by adding and removing surfaces as well
as changing the width and slope of the surfaces. Changing slopes can be done either by specifying
the height difference between two surfaces or by specifying the percentage slope between them.
Also, you can specify a height offset for the profile, where the baseline is indicated by a gray line in

the 3D view.

N: 1124655.07
E: 611020.40
H: 107.23

Station: 0.95m

(@[Es 7.65m

Height: -

Side: CL-vej_02 (0.95 m) G

Edit profile

Profilename [

Profile offset ()

The profile can be rotated by using ‘Edit direction’. North corresponding to 0 (zero) degrees. The

feature ‘Get direction from tool’ will align the profile according to the bucket/attachment.



As an alternative to going via the menu, you can jump to this feature by tapping the profile in the 3D

view.

4.10. Project offset

Project offset is designed to adjust a machine's height to match the height of the design project you
are working on. Even if a machine is correctly calibrated, the height measured by the tool point in
the application can differ from the height of a known point on the project. These differences can
occur as a result of differing reference systems, e.g.: localized coordinate projections vs. official
coordinate projections. Other sources include small variations between GNSS manufacturers as well

as incorrect heights used in the initial project design.

To mitigate this, we have added the project offset functionality, which adjusts the received GNSS

height (not the antenna height) to match the height of the known point on the project.

Note:

You must ensure that the machine is calibrated correctly before adjusting the project offset.

Project offset is limited to adjustments of +/- 50 cm.

Project offset can be adjusted in: Main Menu > Project > Project offset

< Project

Geodetic systems
Extend surface
Plane

Temporary profile

Project offset

Change offset




How to use:
1) Inside the project offset menu, you will see the tool point height of your application in the

value area.

Project offset

2) Enter the correct height of the known point in the value area to calculate a project offset.

3) ltis also possible to adjust the project offset using the +/- buttons, increasing or decreasing

the value by 1 cm per tap.

4) A project offset is calculated and visible in the project menu. When you have a project offset,

the icon will be visible on the work screen.

- -

To remove the project offset, go into the Project Offset menu and tap the trash can icon.



4.11. Change offset

E: 75738.01

Entering this menu adjusts the height offset you want to have for the whole project. Typical uses are
where you have only been given the surface of a road and should dig for a ditch or other layers
beneath the surface. If the ditch is known to be 0.85 meters under the finished road, then adjust the
offset value t0 -0.85. A parallel surface/line will then be created 0.85 meters beneath the theoretical

model. The whole model will be offset.

You can enter the desired value manually or move your finger up or down in the vertical field.



Change offset

0 .
X @® Show original model v

If you have applied an offset but want to view the model with its original offset, enable 'Show Original
Model'.

Change offset

0 .
X @ Show original model v




5. Display
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5.1. Labels

A label is the name of a geometry object of the following type:

e Points

e Lines

e Surfaces

e Stations

e |og Points

e Log Objects

e Texts

It is possible to choose which type of label should be visible by selecting/deselecting it on the list.

N: 1124658.73 > N: 1124658.73
E: 611047.77 E: 611047.77
H: 97.68 H: 97.68

é Main menu | Display é Main menu | Display | Labels

Labels Points

Dark theme Lines
Show maps Surfaces
Transparent surfaces Stations

Select screen sidebar Log points

<& Show textures Log point codes



5.2. Screen indicators
It is possible to hide some of the screen indicators in the work screen area. This function is

designed to let you remove non-essential features, that could be distracting on the screen.

With all screen indicators:

B (Y » '@‘ ﬁl < Screen indicators

Simulator

H: 233.98 Cloud status

M/N0.0 ey GNSS status

Station
Centerline

Height

Station: 136.26 m
CL: 26.11m

Height: - o Side

Side:
0.0% 7. 7%

i O
b -' 45645655 - Pipe.

With selected screen indicators:
ot @ ﬁl < Screen indicators
H: 233.98 Cloud status
KR —P — GNSS status
Station

Centerline

Height

Station: 136.26 m
Height:

Side

0.0% 7.7%

o)
h. l' 45645625 - Pipe




5.3. Use file color

This feature changes between using the colors stored on file or the default color scheme of Makin’
3D. In some situations, it gives a better overview using the colors of the model file and will make it

easier to separate elements in a complex file.
If file color is not enabled, Makin’ 3D will use default colors.

Be aware that some files can include black-colored lines or designs, and these will not be visible if

the file color is selected.

e Tap to select/deselect file colors

é Main menu | Display

Auto hide RMS

Reverse quick keys
& Show other systems

44 Use file color

@ Wireframe

View settings




5.4. Show maps

The user can hide or show maps along with the project to get a better overview. The map will be

shown below the lowest active 3D reference in the project.

The tool cuts are shown on the map in Top View. Otherwise, tool cuts are only shown on elements

of the 3D model marked as a height reference.

Note: In the 3D View, the map will be seen in a perspective view. If you want to see it straight from

above, use the Top View instead.

e Tap to select/deselect visibility of map

N: 1124665.34
E: 611041.72
H:100.25

@ #

N: 1124665.34
E:611041.72
H:100.25

Station:  0.00 m

@3 30.00 m
Height: -

Side: -3(0.00 M) &=

Station:  0.00 m

CL: 30.00 m
Height: -

Side: -3(0.00 m) &

é Main menu | Display

Labels

é Main menu | Display

Labels

Dark theme Dark theme

Show maps 2 Show maps
Transparent surfaces Transparent surfaces

Select screen sidebar Select screen sidebar

<& Show textures & Show textures




5.5. Show other systems

N: 6240851.93
E: 461840.48
H:59.70

Station: -

@Ls

Height: -

Side: P135(3)(9.42 m) &m

é Main menu | Display

Auto hide RMS

Reverse quick keys
0da  Show other systems
4A  Use file color

@ Wireframe

View settings

Other systems currently working on the same project—like machines, rovers, etc.—will show up.

N: 6240851.93
E: 461840.48
H:59.70

Station: -

@Ls

Height: -

Side: P135(3) (9.42 m) &m

é Main menu | Display

Auto hide RMS

Reverse quick keys
0d. Show other systems
4A  Use file color

@ Wireframe

View settings




5.6. Show textures

Instead of using solid colors, you can have textures shown. This is only possible with road geometry.

N:1124659.54 N:1124659.54
E:611016.67 E:611016.67
H:98.92 — H:98.92

Station: 0.00 m Station: 0.00 m
CL: 4.56 m CL: 4.56 m
Height: - Height: -

Side: - Side:

é Main menu | Display é Main menu | Display

Labels Labels

Dark theme Dark theme
A\ Show maps 2 Show maps

Transparent surfaces Transparent surfaces St 7220
CL: 2.01m

Select screen sidebar Select screen sidebar e

Y& Show textures & Show textures an A O




5.7. Tool point coordinates

You have the option to show or hide the tool point coordinates in the app. When activated, the

coordinates for north and east will be displayed along with the height. If deactivated, only the height

will be shown.

< Display

Transparent surfaces
% Show textures

Tool point coordinates

Machine speed

Reverse quick keys

Auto hide quick keys

E: 610979.35
H:101.58

< Display

Transparent surfaces
% Show textures

Tool point coordinates

Machine speed

Reverse quick keys

Auto hide quick keys




5.8. Machine speed
This feature ‘Machine speed’ shows the speed of the machine, working like a speedometer. The
speed is displayed in kilometers per hour (km/h). When activated, the speed will appear in the top

left corner.

& ma X & ma X

H: 103.89

km/h: 3.5

H: 103.89

4

A

o

A
141X

< Display B

Dark theme

< Display

Dark theme

2\ Show maps 2\ Show maps

Transparent surfaces Transparent surfaces

<& Show textures <& Show textures

Tool point coordinates Tool point coordinates

Machine speed Machine speed

5.9. Auto hide quick keys

Auto Hide Quick Keys will hide the “quick keys” at the bottom of the screen after about 8 seconds of

not touching the display.

When you touch the display, they become visible again. It will give you a clearer view of what you are

working on when icons are hidden.



5.10. Reverse quick keys

This feature places the quick keys to the right of the menu button. It makes it more convenient to
log points from the right-hand side of the screen without having to visually locate the point logging

feature.

é Main menu | Display

Select screen sidebar

Y& Show textures
Auto hide quick keys
Auto hide RMS

Station:  74.96 m
Cls 21.36 m

Station:  74.96 m
Cls 21.36 m

Height: - ‘ Reverse quick keys

Side: centerlinie (74 96 M) =

2.0 Show other systems

Height: -
Side: centerlinie (74 96 m) &=




5.11. Transparent surfaces
Hide the surfaces to be able to see lines and points beneath them.
Note: Surfaces with textures will not be transparent.

Warning: Reference selection is not visible when transparent surfaces are enabled.

N: 6240877.81
E: 461853.02
H: 44.88




5.12. Dark theme

By default, the machine control system has the ‘Dark theme’ enabled, which is great at night time or
when working in dimmed conditions. It is recommended to disable this feature when working in a
bright environment, especially while working in direct sunlight when staking out points outside the

cabin, etc.

(@) X [ - o P

simulator

E: 75793.95 E: 75793.95
N:1314228.06 I N: 1314228.06

H: 232,99

510 m -2.5%

0.51Tm -3.0%
Height: 1.01_111_Trau
Side:  centre_111_Trau

é Main menu | Display

Auto hide quick keys

Reverse quick keys
Transparent surfaces
Dark theme
Wireframe

Change screen

Chang; reen

H: 232.99

= 35.10 m -2.5%
CL: 0.51 m -3.0%
Helght: 1.01_111_Trau
Side: centre_191_Trau

e Main menu | Display
Auto hide quick keys

Reverse quick keys

Transparent surfaces

Dark theme

® Wireframe

Change screen

Change creen




5.13. Wireframe

Tap Wireframe to enable the triangular design to be visible. This will show the edges of the triangles

and might improve their visibility.

@ ¥

N: 1124152.96
E: 610958.50
H: 93.64

Station: 504.37 m
Gl 3.47m
Height: -

Side:

é Main menu | Display

Auto hide RMS

Reverse quick keys
0da  Show other systems
4A  Use file color

@ Wireframe

View settings

5.14. View settings

To obtain a better overview of your work, you now have the option of hiding the excavator or making

it transparent.

Open the menu and select Display. Scroll down to View settings.

It is possible to set this individually for a work situation or when you touch the screen. You can also

choose individual settings for work screens with 3D View or Top View.

You can now easily toggle between 3D View and Top View by pressing the icon in the upper right

corner.



N:1124152.96
E: 610958.07

Station:  504.37 m
3.28m

é Main menu | Display | View settings | Top view
When working

When touching screen

() ¥

N:1124152.96
E: 610958.07
H:90.12

/ 504.37 m

é Main menu | Display | View settings | 3D view
When working

When touching screen

Menu > Display > View settings > Top view

@ ¥

N:1124152.96

Station: 504.37 m
CL: 3.28m
Height:

Side:

x é Main menu | Display | View settings | Top view x

Visible When working Shadow

Visible When touching screen Shadow

Menu > Display > View settings > 3D view

N:1124152.96
E: 610958.07

x é Main menu | Display | View settings | 3D view

Visible

When working Shadow

Visible When touching screen Shadow

N:1124152.96
E: 610958.07

Station: 504.37 m
CL: 3.28m
Height:

Side:

é Main menu | Display | View settings | Top view
When working

When touching screen

%

N: 1124152.96
E: 610958.07
H:90.12

Station: 504.37 m
cL: 328 m

é Main menu | Display | View settings | 3D view

When working

When touching screen

X

Hidden
Hidden

Hidden
Hidden




5.15. Change screen

This option is to change the working screen. Tap the icon in the top right corner and select the work

screen option you want to display.

Stadon:  105.1C4ul Stadon:  105.1C4ul




6. Settings
( Main menu E X
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6.1. Tolerances

Tolerances are thresholds for calculations. They are used for different indications, like colors and

sounds. You can change the tolerances for height, side, and alert.

When working outside the specified tolerances, the indicator in question is shown in white color.



6.1.1. Height tolerances
1) Tap ‘Height'.

< Settings

Height

Side distance
Alert
Measure time

Language English

Length unit Meters

2) Tap ‘Heigh tolerance’.

< Height

% Snap to surface

=| Height tolerance

3) Choose any of the 3 options (Red, Yellow, Green).

( Height tolerance

Green above

Qregn below

%) Sound




4) Enter the tolerance.

Yellow

The ‘Yellow’ band for the height tolerance indicates a distance for when to start showing that you

are near a selected height reference.

‘Green above’ and ‘Green below’ are the limits for the accepted height deviation, respectively above
and below the reference. As long as your measurements fall within these green zones, the deviation

is within the allowed range, and the job meets the required standards.

‘Red’ is an indication of excavating too deeply into the ground. The tolerance is an expression for

when to ignore the warning when you are far below the reference.

The sound option will enable different sounds depending on the band within which you are working.

There will be no sounds when working above the yellow band and below the red band.



6.1.1.1. Snap to surface

If you have multiple height references activated, you can select whether the tool point should snap
to the lowest or the highest surface. This means that when height references for multiple layers are
active, the tool point will automatically snap to either the lowest or the highest surface, depending

on your chosen setting.

1) Go to Settings > Height.

2) Tap on ‘Snap to surface’.

< Height

% Snap to surface

Height tolerance

3) Choose between ‘Lower’ and ‘Upper’ to snap to the lowest or highest surface depending on
your preference.

( Snap to surface

Upper

Lower

4) Thetool point will now snap to the lowest or upper surface depending on your chosen setting.



Station: _190.11-m
CL.— 38.0cm
Height: 2A-&n

e g
é 227




6.1.2. Side tolerances

For the side distance, ‘Red’ means that you are approximately within reach of your target, and ‘Yellow’

means that you are even closer. The ‘Green’ band indicates the accepted deviation from the target.

Keep in mind that the side distance is calculated horizontally and is not the shortest path.

< settings

$ Height

<+> Side distance

A Alert

) Measure time

B3 Language English

™ Length unit Meters

2)

< Side distance

mm Side tolerance

3) Choose any of the 3 options (Red, Yellow, Green).



( Side tolerance

102r

Yellow

Green

4) Set the tolerance.

Yellow




6.1.3. Alert tolerances
The tolerance for alert is divided into Show, Warning, and Danger.

e If you arein the ‘Show area’, a red 3D line will be shown.

e If you are in the ‘Warning area’ you will get a warning notification saying, “Too close”.

e If you are in the ‘Danger area’ you will get a danger notification, and an alarm will sound if

turned on.
1)
< Settings
$ Height

<«» Side distance

A Alert

0D Measure time
B3 Language English

™ Length unit Meters

2)

< Alert

m Alert tolerance

3) Choose any of the 3 options (Show, Warning, Danger)



) Sound

4) Change the distance you want from the point of alert.

Warning

You will have a sound option as well. Activate the button for sound or deactivate it for mute sound.



6.2. Measure time

For the most accurate measurement in the Makin’ 3D app, you can adjust the measured time
settings. You can also improve accuracy by allowing the sensors to stabilize and reducing

surrounding noise from GNSS by delaying the measure time.

< Settings
@ Leveling meter

3 Height

<> Side distance

A Alert

@ Measure time

B3 Language English

In the 'Measure time' menu, you will see two functions: Measurement time and Delay time. These
settings allow you to fine-tune the measurement process for the most precise results. Learn more

about how to use these settings in the following paragraphs.

< Measure time

[y Measurement time

(% Delay time




6.2.1. Measurement time

When you use the 'Measurement time' function, you can specify a duration for the Makin’ 3D app to
measure. This feature accounts for GNSS fluctuations by averaging the data for greater accuracy.
Forinstance, if you set the measurement time to 1 minute, the app will calculate the average position

after one minute for a more precise reading.

1) Tap on Measurement time.

< Measure time

(% Measurement time

(% Delay time

2) Set your desired measurement time.

Measure time

3) Tap on the check mark to save.



6.2.2. Delay time

With the 'Delay time' function, you have the option to postpone the measurement process in the app.
This delay allows the sensors to stabilize before capturing your position, leading to more accurate
results. For instance, setting a 2-minute delay means the app waits for 2 minutes before starting to

measure your position.

1) Tap on Delay time.

< Measure time

[» Measurement time

(¥ Delay time

2) Set the desired delay time.

Delay time

3) Tap on the check mark to save your selection.



6.3. Language

Select the language of your choice. The language is automatically changed and saved.

( Settings

$ Height

<«» Side distance

A Alert

) Measure time
B3 Language

™ Length unit

6.4. Length unit

English

Meters

( Language

English
English UK
Dansk
Deutsch
Norsk

Svenska

Tap to choose the length unit. It is automatically changed and saved.

( Settings
™ Length unit
Angle unit

) Sound volume

L External buttons

Change application

Technician functions

Meters

Degrees

Low

>

Centimeters
Feet

Inches
Meters

US survey feet




6.5. Angle unit

Tap to choose the angle unit. The angle unit is automatically changed and saved.

( Settings

™ Length unit

.
/= Angle unit

) Sound volume

{ External buttons

d—

Change application

Technician functions

6.6. Sound Volume

Tap the sound volume again and again to change the sound level. Choices are given: Low, Medium,

High, Highest.

< Settings
™ Length unit
Angle unit

%) Sound volume

Meters Degrees

Degrees Percent
Low Permille

> Relative

[4 X
Meters
Degrees

Low

[ External buttons >

A—

Change application

Technician functions



6.7. Area selection

The ‘Area selection’ feature makes selecting objects in areas with many elements (such as points,
lines, or surfaces) easier. When you tap on an area with multiple elements, a list of up to 7 nearby
objects will appear on the screen, which you can choose from by tapping on the object you want to
select. The objects listed are the ones closest to the spot you have most recently tapped. A ring will

briefly appear on the screen to indicate the area you are selecting.

° A

s Asphalt
£ Parking lot
232

o P10 (0)

o P11 (0)
/G

ments. Listing the

Station: 121.22
Gl 27.0 cm
Height: -

Side:

0.0°

You can enable or disable this feature in the Settings menu. When ‘Area selection’ is disabled, only

one object will be selected when you tap on the screen.



< settings

) Sound volume

L External buttons

Change application
Technician functions
Ignore sensor errors

Area selection

6.8. Leveling meter

In the Leveling meter menu, it is possible to turn on or off the height indicator on corner tool points.

It is possible to select between Fixed or Moving arrows.

.0° .0° 0.0°

< Settings E x < Leveling meter
@ Leveling meter
$ Height

<> Side distance

A Alert

) Measure time

B3 Language English

The green bars indicate the surface below the bucket when the plane has been selected.



The arrows and numbers in the circles indicate how far and in what direction you should move the
bucket to match the surface below.

Fixed Moving

Station: 48.22m Station: 49.11m
: 46.0 cm : 32.0cm
ight:  FV ny Gardsplads-2 & ight:  FV ny Gardsplads-2 &
ide: CL-vej (4822 m) & \ ide: CL-vej(49.11 m) &
3 -14.6° 3 -314°
e e Q :

/

Y
o

Road



7. Logging (As-built)
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7.1. Log Point

Log Point is an as-built feature used to document points. You can access it from the Logging

menu or by long-pressing the shortcut on the work screen.

Option A Option B

( Main menu

“ @ it o

Project Display Settings Logging

% W A g

Bucket Chat Status [ELDE]

1) Tap ‘Object’. A list of your most recently used objects will appear.

If no objects are shown, click the folder icon, then select a group of objects to find the one
you need.



( Q' Log point E x < Objects

Attributes General Coordinates Photo We”

9)) Object Line junction
Attributes ‘Jr

Pipe bend

Drainage

2) Choose the object group that suits your task.
( Object groups
District heating
Electricity
Own objects
Road

Sewage

3) Select the relevant object from the list.

< District heating E x

A 4000 - Main supply line

District heating - 140 - Wastewater

AdA 4001 - Branch line

District heating - 14xxx - Wastewater

A 4004 - Material change

District heating - 14xxx - Wastewater




4) Once the object is selected, tap the Log point icon in the bottom right corner to log a point.

Q@ Log point m x

Attributes General Coordinates Photo

‘ 4001 - Branch line

Attributes

5) A notification will confirm the point has been logged, including the point number and object

details.

=N
Point logged

P10
Object: 4001 - Branch line

Undo

< Q@ Log point

Attributes General Coordinates Photo

Q) Object 4001 - Branch line

Attributes

You can press ‘undo’ if you regret your last logging. The confirmation pop-up will disappear after

approximately 10 seconds.

Note! The last used object will remain active until it is changed.



7.2. Log Line

Log Line is an as-built functionality used to document how points are connected. Log Line can be
used to document line breaks where there are changes in slope, direction, or if the project requires

it, to document every line junction.

How to log a line:

1) Press and hold the Log line icon at the bottom of the screen for three secondsgi

o (o) 1]

H: g ﬂ‘?’\

e

2) Choose the object that matches your task.



( Qi © Create line < Object groups

Attributes General

Q)) Object

District heating
Electricity

Own objects
Road

Sewage

3) You can start logging a new line in one of two ways:

a. Option 1: By clicking the ‘+' icon located in the bottom right corner.

( Qi O Create line E x

Attributes General

Q) Object Rainwater




b. Option 2: Close the menu and then click on the log line icon on the work screen.

(e OT@‘EV\

You can add line points by tapping the icon (see picture above).

4) To stop this line, press the cancel log line button at the top of the work screen. w



{<Rainwater> | Line junction

7.2.1. Log a new line from an existing line

It is possible to log a new line from an existing line. For example, you can easily log a line junction

for a sewage project by logging a new line from an existing line.

How to:

1) Click on the line on the work screen, or go to Project > References, and activate the line by

clicking on its name.



+ 1LY X

Utility project A ©@e

]
[ |
v |
|

w]
[ |
v

u
n
]
4
[

2) Click the gray arrow to expand the line and view the line points in the Reference dialog.

+ 12900 X

Utility project A @t
a
u
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w]
[ |
v

u
n
]
4
[



3) Choose the line point from where you want to start the new line and activate the line point by

clicking on it.

4) Click on the ‘Log line’ icon.

)

+ LM X

mm Utility project A @ !
>

v

>

v

y
(]
n
[
[
n
B
4
]

5) You can now log a new line from an existing line.



+ B U X
ﬁ(:)ﬂi!




7.3. Swift between logging points and lines

You can log lines and points at the same time. You can, for example, log a line by short-pressing the
log line icon at the bottom of your work screen, and when you want to log a point, you can simply
short-press the log point icon. Even if you move the machine after logging a point, it remains in log

line mode, allowing you to log points at the same time.

Line logging-mode Logging a point while logging a line:

Point logged Point logged
Added point to line P1
Object: Object: Line junction

Undo Undo

o ! o

Station: - Station: -
G5 - i
Height: - Height: -

- Y ucket, [ Ry
<Raifwater-J Line function 2 <Ralfiwater> i Line junction
- L o v



7.4. Own objects

You can create your own objects this way:

1) Select Logging in the menu.

2) Select ‘Object’.

< Q@ Log point B x

Attributes General Coordinates

Q) Object

3) Tap the folder icon.
( Objects
WE
Line junction

Pipe bend

Drainage

4) In‘Object group’, select ‘Own objects'.



5) Tap'+.

6) Name your object.

( Object groups

District heating
Electricity
Own objects

Road

< Own objects
Ditch
Drainage
Line junction
Rainwater
Road
WElL

New object




7) Tap the check mark to save.

The new object is now stored under ‘Own objects’ and is automatically selected as the default object

for point logging.

7.5. Log offset

You can log an offset for both point and line point heights:

1) Go to Coordinates > Log offset

< Q Leg point E X ( 2/ Q@ Log point

Attributes General Coordinates

Q) Object

Attributes General Coordinates

Northing
Eastern
Height

4 Log offset

2) Enter the measurement for the offset.



Log offset

3) Click on the check mark.

Log offset




4) The result will show two numbers for the height, like this: (0.00) -1.35. The number in the

parenthesis is the logged point's height, and the number after the parenthesis is the

calculated height after applying the offset.

5) Click on the log point icon in the bottom right corner.

< 2/ Q) Log point
Attributes General Coordinates

Northing
Eastern
Height

4 Logoffset

6) You have logged an offset for the point or line point:

< Q@ Log point

Attributes General Coordinates
Northing
Eastern
Height

4 Logoffset




7.5.1. Edit a log offset
To edit a log offset for a point or a line point:

1) Go to Project > References

2) Click on the point or line point name.

- 1

i X

=
=
v
-
®
=
-

ENN

3) Click on the pen tool to edit.



{-LQ4m 2@ [

mm Utility project

v Well
v Makin' Excavator

P25 (1)

4) Go to ‘Coordinates’.

5) Click 'Log offset’.

< Q Edit log point
Attributes General

Northing
Eastern
Height

4 Log offset

A

Coordinates

EEEENERIO

ENR

¢

-




6) Set the offset and click on the check mark.

7) Click on the check mark in the bottom right corner.

< Q Edit log point

Attributes General Coordinates
Northing
Eastern
Height

4 Log offset

8) The offset is now edited.

7.6. Object information and attributes

When a point is logged, several different pieces of information are logged together with the object

and coordinates. Below, you can see a list of information with an explanation of the different values.

Point name: A unique name used to identify N: The measured points northern coordinate.
individual points This value is measured on the tool point




E: The measured points’ eastern coordinate.
This value is measured on the tool point

H: The measured points elevation. This value is
measured on the tool point

VRMS: Shows the vertical accuracy of the
GNSS when the point was logged. Accuracy is
defined on the GNSS antenna, not the tool
point

HRMS: Shows the horizontal accuracy of the
GNSS when the point was logged. Accuracy is
defined on the GNSS antenna, not the tool
point

Mount point: Shows which mount point was
chosen for the connected NTRIP server

Project offset: If an application has a project
offset entered to adjust tool point elevation to
match the elevation of a known point on the
construction site.

ExtSurf: Showing if the point measured is done
on an extended surface value can be 0(no) or
1(Yes)

ToolHeight: Shows the height offset applied to
the measured tool point, e.g. Pole height for
Makin’ Survey, or Tablet height for Makin’
PerFormans

Time: The time where the point was logged
logged in a YYYY-mm-dd HH:MM:ss format
Example: 2022-02-15 09:43:34

SystemName: Shows the name of the system
that logged the point. This system name
matches the system name on the Cloud

PDOP: Dilution Of Precision, indicates how
errors in measurement will affect the absolute
position calculation. Dop can be calculated in
different variants. (HDOP, VDOP, PDOP, TDOP,
GDOP)

The DOP value logged in the as-built data is the
PDOP value. (Position dilution of precision)
This can be considered as the 3D DOP. The
value is relative and not related to a specific
measurement unit.

Sats: Showing how many satellites were visible
when the point was logged. The value is the
sum of satellites, and not divided into specific
satellite constellations (GPS, Glonass, Beidou,
Galileo)

LogOffset: Delta height. Shows if the operator
has added an offset to the logged point. Often
used if it is impossible to log the exact position
due to limited space. E.g., logging the inlet in a
manhole. Then the operator can log a point on
the top of the manhole, measure the distance
from the measured point to the inlet, and enter
this as a delta height.measured. Value shows
accuracy in meters

SiderefFile: Side reference file. Shows the
name of the file used as active side reference
when point was logged

App: Shows which system has logged this
specific point.

SiderefName: Side reference name. Shows the
name of the specific reference inside the
reference file, used as an active side reference
when a point was logged.

HeightOffset: If the operator has entered an
offset, the value is documented in this field.
This offset will have a direct effect on the Href
value.

Sidedist: Shows the horizontal distance from
the tool point to the side reference when the
point was logged.




POI: This is set if the operator has marked a
point as a Point Of Interest. The value can be 0
(no) or 1 (yes).

HeightrefFile: Height reference file. Shows the
name of the file used as the active height
reference when the point was logged.

ToolPoint: Shows which tool point was used to
log the point. Only relevant for Excavators that
can switch and log with Left, Center and Right
tool point on the bucket.

HeightrefName: Height reference name.
Shows the name of the specific reference
inside the reference file, used as the active
height reference when the point was logged.

Height: Shows the vertical distance from the
tool point to the height reference when the
point was logged.

Comment: If the operator has written a
comment for the point, it will be shown here.

7.7. Sort as-built data

Inside the reference menu, it is possible to enable sorting of the project’s as-built data. Press the AZ

button to open the sorting dialog.

N:1314172.41
E: 75748.08

H:234.81 2

< a+L¥AvIX

mm Road Project

A LLLAA VLS TRV N T YT

v Road model

Vv Surface
> Surfaces

In this dialog, you can choose which criteria you want to sort by. Press the button to activate or

deactivate the criteria. You can also change the order you want to sort by. This is done by pressing

ﬁ(:)ﬁx !
|an
am
[ |

and holding on a criterion and then moving it up or down the list.




Sort as-built

1z

> Point code
:: POI

:: Application

i Creator

it Geometry type
;i Date

o Accept




8. GNSS

<Mainmenu Ex
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8.1. Correction source

In the ‘'GNSS’ menu, you can choose whether you want to run with the GPS receiver towards NTRIP
(CPOS, Smartnet, TopNet) or UHF (radio) towards a local base station. If you choose UHF, you must

select the frequency and ID that allow Makin’ 3D to communicate with the base you want.

How to choose and create a correction source:

1) Go to GNSS > Correction source



@ IE’ S:ficr

H: 104.23

km/h: 0.0

€ oNss [ X
GNSS device Hemisphere

Correction source

RMS warning threshold 0.05m

2) Inthe correction source dialog, you can activate and deactivate NTRIP and UHF profiles.

You can also create or edit a correction profile.

< Correction source + Ve E x

[ dk.nrtk.eu- 10300 ®

“1" UHF_1

Radio not supported

3) To create a correction profile, tap on the + symbol. Edit a correction profile by tapping on the
pen tool.



< Correction source + /’ E x

[ dk.nrtk.eu - 10300 o

“1" UHF_1

Radio not supported

4) When tapping on the ‘+’ symbol you can choose between creating a NTRIP or UHF profile.

See the paragraphs below for more information about UHF and NTRIP.

8.1.1. Radio (UHF)

Under ‘Correction source’ you see the current type of correction source being used.

e Choose ‘UHF’ if you use a radio to connect to the correction signal.

How to create a new UHF profile:

1) You can create a new UHF profile by tapping on ‘+' symbol and then the UHF icon.



2) To set up the UHF profile, the following details must be entered:

< UHF(1)
((II) Name

1 Bandwidth

"\, Frequency

ﬁ Protocol

QreC

23 Scrambling
UA) Base ID

¢ Name: Name the UHF correction profile.
e Bandwidth: Select either 25000Hz or 12500Hz.
e Frequency: Tap ‘Frequency’ to set the frequency of the base station.

e Protocol: Choose the protocol you want to use.



< Edit protocol

Satel

PacCrest 4-FSK
PacCrest GMSK
TrimTalk450S P
TrimTalk450S T
PacCrest FST

e FEC: Tap the button to activate or deactivate the FEC.

e Scambling: Tap the button to activate or deactivate the scrambling.
e Base ID: Tap ‘Base ID’ and choose ‘Auto’ to automatically jump between base stations with

the same frequency or choose an ID of a specific base station to lock on to it by tapping on
‘Custom’.

Please note, that if you use the ‘Auto’ option, you might experience corrections from two
bases, which is not optimal.

1) Choose between ‘Auto’ or ‘Custom’ to set the Base ID.

< Editbase D

Auto

Custom

2) Tap on ‘Custom’ to choose an ID of a specific base station.



< Editbase ID

Auto

Custom

3) Set the ID of the specific base station you want to lock on to. Tap on the check mark to

save.

< Custom Base ID

When you have created a UHF correction profile, you can activate the correction source you want to

use. The current correction source will automatically deactivate.

( Correction source + /’ m X

[ dk.nrtk.eu 10300
" NTRIP

“1" UHF_T

“1" UHF_2




8.1.2. NTRIP

Makin can use corrections from several NTRIP providers. Depending on the installed GNSS receiver,
the information must be entered by the Makin’ supporter or installer in the Makin’ application's GNSS
menu. Makin needs some NTRIP server details to be able to connect to the server and receive useful
corrections. These details will be delivered from the selected NTRIP provider when subscribing to

an account.

1) You can create a new NTRIP profile by tapping on ‘+ symbol and then the NTRIP icon.

2) To connect to the NTRIP network and receive corrections, the following details must be
entered:

o
- Username

P Password

‘ﬁ Mountpoint

e NTRIP name: Name the NTRIP correction profile.

e NTRIP server: The web address where the server can be accessed.



e NTRIP port: This is usually a 4-digit number from where Makin must receive the corrections.

e NTRIP username: Every Ntrip account on the server has a unique username that Makin needs

to log in to the server.

e NTRIP password: Every Ntrip account on the server has a unique password that Makin needs

to log in to the server.

e NTRIP mountpoint: This mountpoint defines which corrections and from which GNSS

satellites Makin can calculate an accurate position.

Please note that the mountpoint is custom. You need to fill in the details for the mountpoint.

1) Tap on ‘Mountpoint’.

a Username
P Password
‘ﬁ Mountpoint

2) Tap on ‘Custom’.

< Edit mountpoint

Custom




3) Enter the mountpoint name. Tap on the check mark to save.

Custom mountpoint

When you have created a NTRIP correction profile, you can activate the correction source you want

to use. The current correction source will automatically deactivate.

< Correction source + V4 m X

[ dk.nrtk.eu - 10300 J
G NTRIP ®
“1" UHF_1

((I)) UHF




9. Bucket
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There is a shortcut to this menu from the quick keys in the bottom left corner of the work screen

v |
Bucket

2.40'm

You can create a new bucket or see all the buckets saved on the tablet. Tap the bucket you want to

use, and always ensure that the calibration is correct before starting work.

Create a new bucket:

Tap the '+ button to create a new bucket.

Edit an existing bucket:

Select an existing bucket and tap on the pen tool to edit the bucket’'s name and measurements.

For calibration, see Chapter 72: Calibration.

To check your calibration, see Chapter 72.3: Check the calibration of your wheel loader.



9.1. Cutting Edge

You can select the position of the active tool point to be at either the front or back of the bucket.

This allows you to place the cutting edge where it best suits your task.

1) Go to Main menu > Bucket.

2) Tap on ‘Cutting edge’.

< Bucket CT [' E X
Cutting Edge Front

o)

Bucket 2.400

2.400m

3) Choose between ‘Front’ or ‘Back’.

< Cutting Edge

Front

Back




9.2. Auto-Corner

Du kan manuelt vaelge, hvilket hjgrne af skovlen du vil bruge som veerktgjspunkt, men hvis din
maskine har tilt, kan du alternativt bruge Auto-Corner-funktionen. Nar Auto-Corner-funktionen er
aktiveret, veelger systemet automatisk det laveste punkt pa skovlen som veerktgjspunkt.

( Bucket _I' E ) ¢

Cutting Edge Front

Co) +

Bucket 2.400
2.400 m

Nar funktionen er aktiveret, vises Auto-Corner-ikonet i topbjeelken, og det angiver Igbende, hvilken
side af skovlen du maler fra, afhaengigt af hvordan skovlen er tiltet.

X

Simulator

oy ¥

Simulator




10. Chat

The chat feature helps you communicate with your colleagues about the project you are working on.

< Main menu

“ @ 1l

Project Display Settings Logging

A

Bucket Status Manual

e You will see all office personnel and coworkers from your company or project. This depends

on the structure created by your management.

e Tap a contact from the list to begin messaging.

. I -~
Select conversation Alexander

Lars

= I

Morten

KlausSpandet

Glen

Hi Alex please come to the

e Write a message and tap ‘Send’.



11. Status

This is where you will find various details about the system information.

( Main menu

A @ i

Project Display Settings Logging

A B

Bucket Status Manual

e Tap ‘GNSS' to see the connection status and your location.
e Tap ‘Sensors’ to see detailed sensor information.

e ‘Version' is the current Makin’ 3D software version of the Android app running on your tablet.

e ‘IB-1 version’ is the firmware version of the interface box connecting all the sensors to the
system.

é Main menu | Status

GNSS
Sensors

Version

IB-1 version




e System info: You can find all relevant information about your system by selecting ‘System
info’. Information such as System name, System number, System owner, and the associated

licenses are shown here. When changes are made to the system, they will be shown under

System info.



12. Calibration

12.1. Bucket calibration

Always place your machine on the most stable surface possible and read through the full chapter

before starting.

12.1.1. Tools required

e Spirit level

o Tape measure

12.2. Bucket calibration menu

Go to the bucket menu from the main menu. See Chapter 9: Bucket, for further details.

<Mainmenu Ex
“w @ it O ¥

Project Display Settings Logging GNSS

Bucket Chat Status [\ ETIE]




Add a new bucket

If you want to add a new bucket, tap the ‘+' symbol.

Calibrate a bucket
1) Tap the bucket you want to calibrate.

< Bucket S [ X

Cutting Edge Front

o0
4in1 Bucket Bucket with tilt Bucket 2
250m 240m 240m 0.50m

(=] (=) (=)
5% % » %

+

2) Tap the pen symbol to begin calibrating.



< Bucket V4 E X < Bucket -li]- E X

Cutting Edge Front Name Bucket

Blade wear front 0.250 m
(=) (=) (=) (=)
o ) o )

4in1 Bucket Bucket with tilt Bucket 2
250m 240m 240m 0.50m

Blade wear back 0.800 m

Flat angle 0.00°

Blade offset back 0.000 m
Depth 0.900 m

+

12.2.1. Bucket name

In the bucket calibration, tap ‘Name’ to edit the name of the bucket. Type the name and tap the check

mark to save.



12.2.2. Blade wear front
In the bucket calibration, tap ‘Blade wear front’ to enter the length of the front blade. When the blade

wears out, enter the new measurement for accurate calibration.

12.2.3. Blade wear back

Tap ‘Blade wear back’ to enter the length of the back blade. Measure the distance from the back of

the front blade to the back of the back blade. When the blade wears out, enter the new measurement

for accurate calibration of the back blade.




12.2.4. Flat angle

1) Place a spirit level underneath the cutting edge of the bucket. Move the bucket so the cutting

edge lies horizontally.

2) Press ‘Reset’ if the bucket is horizontal.

3) Click on the check mark to confirm the offset and calibrated value.

Makin' Wheel Loader User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS 152



12.2.5. Blade offset back

If there is a height difference between the front and back blades, enter the offset value for the back

blade. The offset is the height difference between the blades.

12.2.6. Depth

In the bucket calibration, tap ‘Depth’ to enter the depth of the bucket. Measure the distance from the

back of the front blade to the mount point. Tap the check mark to save.

Makin' Wheel Loader User Guide 2.33, 1st edition, Dec. 2025 © Copyright 2025, Makin AS 153



12.2.7. Width

Tap ‘Width' to enter the width of the bucket. The width is the total working width of the bucket, which

you get by measuring the front blade. Tap the check mark to save.

12.2.8. Mount height

In the bucket calibration, tap ‘Mount height’ to enter the mount height. Measure the mount height,
which is the distance from the bottom of the front blade to the bucket’'s mount point. Tap the check

mark to save.




12.2.9. Height
Tap ‘Height’ to enter the height of the bucket. The height is measured from the bottom of the front

blade to the top of the bucket. Tap the check mark to save.

Please note that the software will not accept a height lower than the mount height. If the number
entered is below the mount height, the calibration will not be completed. Pay special attention to
this in cases where a different tool than a bucket, like a levelling beam, is connected to the Wheel

Loader.



12.2.10. Coupler/Tilt

1) Tap ‘Coupler/Tilt' to state which application is present - i.e., None, Coupler/Tilt.

< Coupler/Tilt
None
Coupler/Tilt
Coupler/Tilt (1)
Coupler/Tilt (2)
Coupler/Tilt (3)

2) Tap Tilt offset’ if you have tilt installed. Tilt the bucket until the cutting edge is horizontal,

using a spirit level. Then tap ‘Reset’ and the check mark to save.

Tilt offset |__|7'

Offset
SRz

Calibrated value

0.00
Reset




12.3. Check the calibration of your wheel loader
Before you start your daily work, we advise that a calibration check should be performed.

Also, ensure that the machine you are going to operate is fully calibrated and that your current bucket

is calibrated. Follow these steps:

1) Place your tool point on a known point and verify the position.
2) Optionally place corner tool points on a known point one by one to verify the position.

3) If your reading is within the project’s tolerances, your calibration is okay; otherwise,

recalibrate.

12.4. Calibration backup

You can save a backup of the machine's current calibration file. If the same tablet is used on
different machines, you can also save each machine's calibration as a separate backup, making it
easy to access the correct file.

12.4.1. Snapshots

Every hour, the snapshot function automatically creates a backup file of the current calibration, or
whenever changes are made to the calibration. Please note, however, that if multiple changes are
made within the same hour, the previous file will be overwritten.

You can at any time change back to a previous calibration by selecting a backup file, as described
in section 72.4.3: Select Backup File.

Please note that at the end of the day, the system automatically reviews the day’s backup files and
clears the list so that only the latest calibration remains available



12.4.2. Manual backups

To manually create a backup file, follow the description below.

Step Action lllustration
1 Open Machine configurations in the Settin 7
gs
Settings menu. < |_—, x
[ External buttons >
Change application
Machine configurations
Technician functions [
Ignore sensor errors o
Area selection
2 Select MyMachine. < Machine config files z X
MyMachine
3 Select Manual backups.

( Calibration backup E x

Snapshots

Manual backups




4 Tap the +icon to create a new backup. | [P VINTRERREIN [ X

5 Give the backup a name.

Please give the backup a name m

MyMachine_2025-11-27

6 Save by tapping the check mark. Please give the backup a name

MyMachine_2025-11-27

NB! The backup file will now be visible in the < Manual backups
Manual backups menu.
MyMachine_2025-11-27




12.4.3. Select backup file

Please note that the procedure for selecting a backup file is the same for snapshots and manual

backups.

Step

Action

Illustration

1

Tap on the calibration file you want to
apply to your system.

( Snapshots E x

MyMachine_2025-11-07_12-01

MyMachine_2025-11-11_16-03

MyMachine_2025-11-20_14-09

MyMachine_2025-11-21_11-35

MyMachine_2025-11-24_16-19
MyMachine_2025-11-25_15-26

A notification appears on the screen.
Tap on the check mark to confirm.

Attention

Are you sure you want to load:
MyMachine_2025-11-21_11-35? This will overwrite current
calibration.

X




13. Troubleshooting

Error message Possible cause Possible Solution

If you cannot solve the problem using the advice found in the above table, contact your reseller.



14. Appendix
14.1. Software updates

When updating the Makin’ 3D app to a new version, you might receive a notification from Google

Play Protect. To proceed with the installation, allow Google Play Protect to scan the app. This

ensures the new software version is safe to install.

1) Tap on ‘Scan app'’.

© Google Play Protect

App scan recommended

S Vekinmd

2) Tap ‘Install'.



© Google Play Protect

This app looks safe

% Makin 3D

Station: 253.32m
1.61m

3) The Makin’ 3D app is now updating to a new software version. Please wait while the update

is installed.



14.2. GNSS limitations

Always take into consideration where your machine is located. Especially when X

the construction site is within city limits with tall buildings or other obstacles. Sats: 11
DOP: 1.6

Also, if working near forest and mountain areas, interference could block the signal from one or

more satellites and cause poor precision. Reflections could also occur.

Makin’ 3D will inform you if there are not enough visible satellites or if your CQ/DOP is too high.

1. Direct signal blocked 3. Multipath errors

2. Direct signals perfectly received



14.3. Frequency

In situations where you have to specify the frequency according to a channel, refer to the table below
for guidance. Channel 0 is the center frequency, and channels are distributed with a 25 kHz spacing

(in this example).

Channel Frequency (MHz)
0 446.6000
-1 446.5750
-4 446.5000
-5 446.4750




14.4. Compliance information

This product is intended to be mounted on earth-moving machinery exclusively for professional use,
i.e. the product falls into the category: non-road vehicles exclusively for professional use. Makin
hereby declares that the system and its components fulfill the requirements of the following EU

directives applicable to this product category:

e 93/68/EEC - CE conformity marking
e 2014/53/EU - Radio Equipment Directive
e 2014/30/EU - EMC directive

o DS/EN/ISO 13766-1:2018 - Earth-moving and building construction machinery —
Electromagnetic compatibility (EMC) of machines with internal electrical power
supply — Part 1: General EMC requirements under typical electromagnetic

environmental conditions

o DS/EN/ISO 13766-2:2018 - Earth-moving and building construction machinery —
Electromagnetic compatibility (EMC) of machines with internal electrical power

supply — Part 2: Additional EMC requirements for functional safety

The respective product category falls outside the scope of these directives:

e 2011/65/EU - RoHS
e 2012/19/EU - WEEE



14.5. Tablet connections

14.5.1. Tablet Panasonic FZ-A3 connections

The Panasonic FZ-A3 has connectors located in four places: on the top, on the side, inside the battery

compartment, and at the bottom.

1. Mini-jack audio output 4. 16 V DC input power for external
charger
2. Micro SIM card for broadband internet 5. USB-A

on both tablet and GNSS receiver

3. Docking station connector for data and 6. USB-C
power transmission



14.5.2. Tablet Panasonic FZ-A2 connections

The Panasonic FZ-A2 has connectors on the top, on the side, inside the battery compartment, and

at the bottom.

1.16 V DC input power for external 5. HDMI output to external screen
charger
2. Docking station connector for data and 6. SuperSpeed USB-A 3.0

power transmission

3. Micro SIM card for broadband internet 7. Mini-jack audio output
on both tablet and GNSS receiver

4. USB-C 8. Micro SD for extended storage



14.6. Docking station connections

1. 16 V DC input power for external 3. 2x HighSpeed USB-A 2.0
charger

2. RJ-45 Ethernet



14.7. Tablet set-up

14.7.1. Tablet buttons and light indicators (Panasonic FZ-A2)

mAaiKnm 3o

1. On/Off button

2. Power indicator

No light: System is off
Green light: System is on

Blinking green light: Tablet in sleep
mode

3. Charging indicator

No light: External power source
not connected

Red light: Battery power is
critically low. External power
source is not connected.
Orange light: Tablet is currently
charging

Green light: Tablet fully charged

TOUGHPAD

Of

. \

©00000

h"

4. Auto-rotate screen. The button can be
programmed (more info below).

5. Volume up

6. Volume down

7. Not in use. The button can be
programmed (See section 14.7.2. below).

8. Not in use. The button can be
programmed (See section 14.7.2. below).

9. Basic tablet functionality via the
‘Dashboard’ app. The button can be
programmed (See section 14.7.2. below).



14.7.2. Programming the physical tablet buttons (Panasonic FZ)

The Panasonic tablet has three user-programmable function keys, A7, A2, and A3. You can assign
Makin’ 3D functions to these keys.

Step | Action lllustration
1 Open the app UserButtonManager.
2 Select the physical button to which you want
to assign the Makin’ 3D function (A7, A2 or Usautonanager
A3) Short press
Al . Program 1
A2 : Program 2
A3 : Program 3
AT+A2 : Do nothing
3 When clicked, a pop-up window will open. Erm
SeleCt the deSII'ed fUﬂCtIOﬂ - |t Wl” be Please select a function
labelled Program 1, Program 2 or Program 3 Securty Mode
depending on the button you select in the Launch an application
Makin’ 3D app. Take screenshot
Back
Home
Menu
Program 1
Program 2
Program 3
4 Go to the Settings menu in the Makin’ 3D app.
9 PP < Settings |__7|, x
5 Open the External Buttons menu. ) Sound volume Low

£ External buttons >

Change application

Technician functions ®

Ignore sensor errors o

Area selection ]




Click the button you want to program
(Program 1, Program 2 or Program 3).

Note:

If the button does not appear on the list,
press the physical button, this will add the
option to the list.

< External buttons
Keyboard F2

No action

Keyboard F3

N action

Keyboard F4

Program 1

Log point

Program 2

N action

Program 3

Select the function you want to assign to the
button.

< Program 1 |;|7' x
No action
Change toolpoint

Zero plane

Check that the function has been assigned to
the button. The function appears beneath the
button name. If a button has not been
programmed, it will show the description No
action.

e

Program 2

No action

Program 3

No action




14.8. Interface Box (IB-1)

Status information on the interface module can be read out by watching the LED just next to the

power connector.

Color Indication

Green ON - all ok

Flashing red Firmware issue - contact reseller
White System check of software

Blue Updates to software are ongoing




14.9. Demo mode

You can use your Makin’ 3D system on Windows in demo mode to gain confidence in the user

interface.

Please find below the shortcuts for the functions.

Keyboard Action
— Rotate camera left
- Rotate camera right
| Tilt camera down
1 Tilt camera up
Space Start/stop automatic driving
+ Raise machine model
- Lower machine model
Change view (sampling through options)
b Rotate model left
Shiftb /B Rotate model right
m Rotate model right
Shiftm/M Rotate model left
n Drive forward (in direction of cab orientation)
Shiftn/ N Drive backwards (in direction of cab orientation)
s Drive forward along pre-determined line (centreline)
Shifts /S Drive backwards along pre-determined line (centreline)




Jump around close to the project

Shiftj/J Jumps to the roundabout in Odense S

u Jump to current side reference
p Opens the Plan menu
o} Opens the offset menu
g Opens the jog window
w Activate/deactivate wireframe mode
r Refresh / Finds the model
R Reload / reset model orientation (undoes number key modifications)
1 Tilt model to the left (Roll)

Alt 1 Tilt model to the right (Roll)
2 Tilt model forward (Pitch)

Alt 2 Tilt model backwards (Pitch)

3/4/5/6/7/8/9 Move a machine part — follow the machine from the boom outwards

to the bucket. The connection between the key and the machine part
depends on the machine’s configuration.

Alt3/4/5/6/7/8/9

Reverses the movement




14.10. Xbox controller

You can use an Xbox controller to control the machine model in the Makin’ 3D app on your tablet. It
is an easy way to gain confidence in the user interface. This feature is only available when you

connect the Xbox controller to a Panasonic FZ-A3 tablet.
How to connect the Xbox controller to your tablet:

1. Go to Settings on your tablet.

2. Click on Connected devices.

3. Press the connect button on the Xbox controller. The button is located on on top of the

controller (Number 4 on the image below).
4. Click on Pair new device.

5. Click on the available Xbox Wireless Controller on the tablet screen. Wait for the devices to

pair.
6. Your Xbox controller is now connected to the tablet and ready for use.
Please note:

The available functions depend on the machine model activated on the tablet. Use the table below

to see the button functions for this model.



Button direction

Dig mode

Drive mode

1 Press down

Switch to drive mode

Switch to dig mode

1 Forward Arm out Drive forward
1 Backwards Armin Drive backwards
1 left Swing left Turn machine left
1 right Swing right Turn machine right
2 Tilt left Decrease turbo (stepwise)
3 - -
4 Connect controller




5 Power on/off

6 Jump to side reference

7 . .

8 Tilt right Increase turbo (stepwise)

9 - -

10 - -

11 - -

12 forward Boom down Pitch machine down
12 backwards Boom up Pitch machine up

12 left Close bucket Roll machine left
12 right Open bucket Roll machine right

A Move machine down to 1 meter

B Rotate bucket right

X Rotate bucket left

Y Move machine up 1 meter
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